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Common Office Tools
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“The odd thing is he always insists on using
the latest version of Office.”




Chapter 1: Office Nuts and Bolts

In This Chapter

1+ Introducing the Office programs

»* Running an Office program

1+ Exploring the Office interface

1 Saving and automatically recovering your files
1 Opening and closing an Office file

1+ Recording a file’s document properties

1 Clamping a password on a file

‘ hapter 1 is where you get your feet wet with Office 2010. Walk right to
the shore and sink your toes in the water. Don’t worry; [ won’t push
you from behind.

In this chapter, you meet the Office programs and discover speed tech-
niques for opening programs and files. I show you around the Ribbon, Quick
Access toolbar, and other Office program landmarks. I also show you how to
open files, save files, and clamp a password on a file.

A Survey of Office Programs

Office 2010, sometimes called the Microsoft Office Suite, is a collection of
computer programs. Why is it called Office? I think because the people who
invented it wanted to make software for completing tasks that need doing
in a typical office. When you hear someone talk about “Office” or the “Office
software,” they’re talking about several different programs:

4 Word: A word processor for writing letters, reports, and so on. A Word
file is called a document (see Book II).

4 Outlook: A personal information manager, scheduler, and e-mailer (see
Book III).

4+ PowerPoint: A means of creating slide presentations to give in front of
audiences. A PowerPoint file is called a presentation, or sometimes a
slide show (see Book IV).
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Starting an Office Program

4+ Excel: A number cruncher for performing numerical analyses. An Excel
file is called a workbook (see Book V).

4 Access: A database management program (see Book VI).

4 Publisher: A means of creating desktop-publishing files — pamphlets,
notices, newsletters, and the like (see Book VII).

Office 2010 also comes with the Clip Organizer, for managing and insert-
ing clip-art images in files and managing media files on your computer; the
Picture Manger, for inserting and editing pictures; and OneNote 2010, a pro-
gram for taking notes and brainstorming. These programs are explained in
Book VIIIL

If you're new to Office, don’t be daunted by the prospect of having to

study so many different computer programs. The programs have much in
common. You find the same commands throughout Office. For example, the
method of choosing fonts is the same in Word, Outlook, PowerPoint, Excel,
Access, and Publisher. Creating diagrams and charts works the same in
Word, PowerPoint, and Excel. Book I describes tasks that are common to all
or most of the Office programs. Master one Office program and you’re well
on your way to mastering the next.

Starting an Office Program

Unless you start an Office program, you can’t create a document, construct
a worksheet, or make a database. Many have tried to undertake these tasks
with mud and papier-maché without starting a program first, but all have
failed. Here are the various and sundry ways to start an Office program:

4+ The old-fashioned way: Click the Start button, choose All Programs=>
Microsoft Office, and then choose the program’s name on the submenu.

4 The Start menu: Click the program’s name on the Start menu, as shown
in Figure 1-1. The Start menu is the menu you see when you click the
Start button. By placing a program’s name on the Start menu, you can
open the program simply by clicking the Start button and then clicking
the program’s name. To place an Office program on the Start menu:

1. Click the Start button and choose All Programs=>Microsoft Office.

2. Move the pointer over the program’s name on the submenu, but
don’t click to select the program’s name.

3. Right-click the program’s name and choose Pin to Start Menu on
the shortcut menu that appears.

To remove a program’s name from the Start menu, right-click the
name and choose Remove from This List.
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Starting a program along with your computer

Yet another way to start an Office program is * Windows 7 and Vista: C:\Users\

to make the program start automatically when- Username\AppData\Roaming\
ever you turn on your computer. If you're the Microsoft\Windows\Start
president of the Office Fan Club and you have Menu\Programs\Startup

to run, for example, Outlook each time your
computer starts, create an Outlook shortcut
icon and copy it into the Startup folder. Note
which Windows operating system you have,
and copy the shortcut icon into the Startup
folder in one of these locations:

* Windows XP: C: \Documents and
Settings\Username\Start
Menu\Programs\Startup

4 Quick Launch toolbar (Windows Vista and XP only): Click a shortcut
icon on the Quick Launch toolbar (refer to Figure 1-1). The Quick Launch
toolbar appears on the Windows taskbar and is easy to find. Wherever
your work takes you, you can see the Quick Launch toolbar and click
its shortcut icons to start programs. Create a shortcut icon and follow
these steps to place a copy of it on the Quick Launch toolbar:

1. Click the shortcut icon to select it.
2. Hold down the Ctrl key.
3. Drag the shortcut icon onto the Quick Launch toolbar.

To change an icon’s position on the toolbar, drag it to the left or the
right. To remove an icon, right-click it and choose Delete.

Finding Your Way Around the Office Interface

Interface, also called the user interface, is a computer term that describes
how a software program presents itself to the people who use it (and you
probably thought interface meant two people kissing). These pages give you
a quick tour of the Office interface and explain what the various parts of
the interface are. You will be glad to know that the interface of all the

Office programs is pretty much the same. Click along with me as [ describe
the interface and you’ll know what’s what by the time you finish reading
these pages.
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Figure 1-8:
Press the

Alt key to
see KeyTips.

Saving Your Files

4 Go to a tab. Press a KeyTip on a tab to visit a tab.

4+ Make KeyTips appear on menu items. Press a KeyTip on a button or
gallery to make KeyTips appear on menu items.
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Saving Your Files

Soon after you create a new file, be sure to save it. And save your file from
time to time while you work on it as well. Until you save your work, it rests
in the computer’s electronic memory (RAM), a precarious location. If a
power outage occurs or your computer stalls, you lose all the work you did
since the last time you saved your file. Make it a habit to save files every ten
minutes or so or when you complete an important task.

These pages explain how to save a file, name a file, choose the folder where
you want to save a file, declare where you want to save files by default, save
files for use in 97-2003 editions of Office, and handle files that were saved
automatically after a computer failure.

Saving a file

To save a file:
4 Click the Save button (you find it on the Quick Access toolbar).
4 Press Ctrl+S.
4 Go to the File tab and choose Save.

Saving a file for the first time

The first time you save a presentation, the Save As dialog box opens. It
invites you to give the file a name and choose a folder in which to store it.
Enter a descriptive name in the File Name text box. To locate a folder for
storing your presentation, see “Navigating the Save As and Open Dialog
Boxes,” later in this chapter.
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Navigating the Save As and Open Dialog Boxes

On the File tab, choose Options.
The Options dialog box appears.
2. Select the Save category (refer to Figure 1-9).

W

4. Click OK.
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Enter a Minutes setting in the Save AutoRecover Information Every box.

Navigating the Save As and Open Dialog Boxes

The Open dialog box and Save As dialog box offer a bunch of different ways
to locate a file you want to open or locate the folder where you want to save
a file. Figure 1-10 shows the Open dialog box. I'm happy to report that both

Figure 1-10:
The Open
dialog box.

dialog boxes, Open and Save As, work the same way.

4+ Retracing your search: Click the Back and Forward buttons (or open the
drop-down list on the Back button) to retrace your search for a folder or

revisit a folder you previously visited.
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Opening and Closing Files

Putting a favorite folder on the Favorites list

The Favorites list (or Favorite Links list) in 1. In the Open or Save As dialog box, locate
the Open dialog box and Save As dialog box and select the folder that you want to be a
gives you the opportunity to go lickety-split to favorite.

a folder on your computer or network. All you
have to do is click a folder name on the list
to see the contents of the folder. If there’s a
particular folder you visit often that deserves
“favorite” status, you can put that folder on the
Favorites list by following these steps: To remove a folder from the Favorites list, right-

2. Drag the folder into the Favorites list.
That's right — just drag it. Moreover, you
can slide it up or down the list to put it
where you are most likely to find it.

click it and choose Remove Link.

Searching for files in a folder: Use the Search box to search for subfold-
ers and files in the folder you're currently viewing. After you type the
first few letters of a filename or subfolder, you see only the names of
items that start with the letters you typed. To see all the files and sub-
folders again, click the Close button (the X) in the Search box.

Changing views: Display folder contents differently by choosing a view
on the Views drop-down list (in Windows 7, look for the View arrow in
the upper-right corner of the dialog box). In Details view, you see how
large files are and when they were last edited.

Creating a new folder: Click the New Folder button to create a new
subfolder for storing files. Select the folder that your new folder will be
subordinate to and click the New Folder button. Then type a name for
the saved file.

Open one of your favorite folders (Windows Vista): Select a folder
in the Favorite Links list to see its contents. Later in this chapter, the
“Putting a favorite folder on the Favorite list” sidebar explains how to
place the name of a folder in the list.

Navigate to different folders: Click the Folders bar (in the lower-left
corner of the dialog box) to open the Navigation pane and look for fold-
ers or presentations on a different drive, network location, or folder

on your computer. If you don’t see the Folders bar, click the Organize
button and choose Layout>Navigation Pane.

Opening and Closing Files

To get to work on a file, you have to open it first. And, of course, you close a
file when you're finished working on it and want to stop and smell the roses.
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Figure 1-11:
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Closing a file
Closing a file is certainly easier than opening one. To close a file, save your
file and use one of these techniques:

4 On the File tab, choose Close. The program remains open although the
file is closed.

4 Click the Close button — the X in the upper-right corner of the window.
(Alternatively, press Alt+F4.) Clicking the Close button closes the pro-
gram as well as the file.

4 Click the program icon (in the upper-left corner of the screen) and
choose Close.

If you try to close a file without first saving it, a message box asks whether
ditching your file is in your best interests, and you get a chance to click
Save in the message box and save your file. Sometimes closing a file without
saving the changes you made to it is worthwhile. If you made a bunch of edi-
torial mistakes and want to start over, you can close the file without saving
the changes you made. Next time you open the file, you see the version that
you had before you made all those mistakes.

Reading and Recording File Properties

Properties are a means of describing a file. If you manage two dozen or more
files, you owe it to yourself to record properties. You can use them later to
identify files.
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To read property descriptions, go to the File tab and examine the Book |
stun Information window. Property descriptions are found on the right side Chapter 1

of the window, as shown in Figure 1-12.
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To record even more descriptions, click the Properties button and choose
one of these commands on the drop-down list:
4 Show Document Panel: The Document Properties panel appears so that
you can enter more descriptions and comments.
4+ Advanced Properties: The Properties dialog box appears. Enter infor-
mation about your file on the Summary and Custom tab.
You can read a file’s properties without opening a file. In Windows Explorer,
Computer, or the Open dialog box, right-click a file’s name and choose
Properties. You see the Properties dialog box. Go to the Details tab to see
descriptions you entered.
<P Word, Excel, and PowerPoint offer a command for erasing document properties.

On the File tab, choose Info, click the Check for Issues button, and choose Inspect
Document. In the Document Inspector dialog box, click the Inspect button, and
then click the Remove All button if you want to remove document properties.

Locking a File with a Password

Perhaps you want to submit your file to others for critical review but you
don’t want any Tom, Dick, or Harry to look at your file. In that case, lock
your file with a password and give out the password only to people whose
opinions you trust. These pages explain how to password-protect a file, open
a file that is locked with a password, and remove the password from a file.



Chapter 2: Wrestling with the Text

In This Chapter

1 Selecting, moving, copying, and deleting text

1~ Changing the appearance, size, and color of text
1+ Changing the case of letters

v Inserting foreign characters and symbols

v Finding text — and replacing it if you want

1 Hyperlinking to Web pages and other places in a file

T) enter text, all you have to do is wiggle your fingers over the keyboard.
Everybody knows that. But not everyone knows all the different ways
to change the look and size of text in an Office 2010 file. In this chapter, I
explain how to do that as well as how to move, copy, and delete text. You
find out how to quickly change a letter’s case, enter a symbol or foreign
character, and find and replace text in a file. Finally, | show you how to link
your files to the Internet by fashioning a hyperlink.

Manipulating the Text

This short but important part of Chapter 2 describes the many techniques
for selecting, deleting, copying, and moving text. You find an inordinate
number of tips on these pages because there are so many shortcuts for
manipulating text. Master the many shortcuts and you cut down consider-
ably on the time you spend editing text.

Selecting text

Before you can do anything to text — move it, boldface it, delete it, translate
it — you have to select it. Here are speed techniques for selecting text:
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Changing the Look of Text 35

by selecting text and then starting to type. The letters you type immediately
take the place of and delete the text you selected.

You can always click the Undo button (or press Ctrl+Z) if you regret deleting
text. This button is located on the Quick Access toolbar.

Changing the Look of Text

What text looks like is determined by its font, the size of the letters, the
color of the letters, and whether text effects or font styles such as italic

or boldface are in the text. The text’s appearance really matters in Word,
PowerPoint, and Publisher because files you create in those programs are
meant to be read by all and sundry. Even in Excel, Access, and Outlook mes-
sages, however, font choices matter because the choices you make deter-
mine whether your work is easy to read and understand.

A font is a collection of letters, numbers, and symbols in a particular typeface,
including all italic and boldface variations of the letters, numbers, and sym-
bols. Fonts have beautiful names and some of them are many centuries old.
Most computers come with these fonts: Arial, Tahoma, Times New Roman, and
Verdana. By default, Office often applies the Calibri and Cambria fonts to text.

When you're in a hurry to change the look of 3. Drag the pointer across text to which you
text and reformat paragraphs, consider using want to copy the formats.

the Format Painter. This nifty tool works some-
thing like a paintbrush. You drag it over text to
copy formats from place to place. Follow these
instructions to use the Format Painter: 4. Click the Format Painter button a second

1. Click a place with text and paragraph for-
mats that you want to copy elsewhere (or
select the text). Press Esc or click the Format Painter button

2. Onthe Home tab (or the Format Texttab in an
Outlook message), click or double-click the
Format Painter button (or press Ctrl+Shift+C).

You can find the Format Painter button Aal

J; in the Clipboard group. Click the button

to copy formats once; double-click to

copy formats to more than one location.
The pointer changes into a paintbrush.

Format Painter: A fast way
to change the look of text

You can go from place to place with the
Format Painter.

time or press Esc when you're finished
with the Format Painter.

again to cease using the Format Painter if
you used it to copy formats to more than
one location.

At the opposite end of the spectrum
—_+# from the Format Painter button is the
Clear Formatting button on the Home

tab. You can select text and click this button to
strip text of all its formats, whatever they may be.

Book |
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Figure 2-4:
Choosing a
font color
on the mini-
toolbar.
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Quick Ways to Handle Case, or Capitalization

Changing the color of text

Before you change the color of text, peer at your computer screen and exam-
ine the background theme or color you chose. Unless the color of the text is
different from the theme or color, you can’t read the text. Besides choosing a
color that contributes to the overall tone, choose a color that is easy to read.

Select the text that needs touching up and use one of these techniques to
change its color:

4 On the mini-toolbar, open the drop-down list on the Font Color button
and choose a color, as shown in Figure 2-4.
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4+ Right-click, open the drop-down list on the Font Color button, and
choose a color on the shortcut menu.

4 On the Home tab, open the drop-down list on the Font Color button and
choose a color.

4 On the Home tab, click the Font group button to open the Font dialog
box, open the Font Color drop-down list, and choose a color.

The Font Color drop-down list offers theme colors and standard colors. You
are well advised to choose a theme color. These colors are deemed theme
colors because they jive with the theme you choose for your file.

Ouick Ways to Handle Case, or Capitalization

Case refers to how letters are capitalized in words and sentences. Table 2-1
explains the different cases, and Figure 2-5 demonstrates why paying atten-
tion to case matters. In the figure, the PowerPoint slide titles are presented
using different cases, and the titles are inconsistent with one another. In one
slide, only the first letter in the title is capitalized (sentence case); in another
slide, the first letter in each word is capitalized (capitalize each word); in
another, none of the letters is capitalized (lowercase); and in another, all the
letters are capitalized (uppercase). In your titles and headings, decide on a
capitalization scheme and stick with it for consistency’s sake.

Book |
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Entering Symbols and Foreign Characters 43

4+ Capitalize Each Word: Capitalizes the first letter in each word. If you
choose this option for a title or heading, go into the title and lowercase
the first letter of articles (the, a, an), coordinate conjunctions (and, or,
for, nor), and prepositions unless they’re the first or last word in the title.

4+ tOGGLE cASE: Choose this option if you accidentally enter letters with
the Caps Lock key pressed.

You can also change case by pressing Shift+F3. Pressing this key combina-
tion in Word and PowerPoint changes characters to uppercase, lowercase,
each word capitalized, and back to uppercase again.

Entering Symbols and Foreign Characters

Don’t panic if you need to enter an umlaut, grave accent, or cedilla because
you can do it by way of the Symbol dialog box, as shown in Figure 2-6. You
can enter just about any symbol and foreign character by way of this dialog
box. Click where you want to enter a symbol or foreign character and follow
these steps to enter it:

Symbol [F ==
Eont: (normal text) [=] Subset: | Latin-1 Supplement [~]
ilelel=|x|t|g] " |@2]|«|-~|-]2]"|°"
:izs'uﬂ Ve v %Y %|é A
Figure2-6: | |A|A|A|AJA|&[c|E|E[E]ENN|I|T]T]D
To enter R|O|6|O|0|6|x|@|u|u|0|U|Y|p|RI
a symbol alalalalal=|cleleleleli]i]i]ila
or foreign flolslelale|+|e|ulalalaly|p|y A .
character, 5
select it Recertly used symbols: ) ) ) ) ) B
andolick | |v|€[£]¥[@|=[™[+]#|<[>]+]x|~|nla
the Insert LATIN SMALL LETTER & WITH GRAYE Character code: [00ED from: | Uricode thex) [ =]
button. [t | [ cane |
Q 1. On the Insert tab, click the Symbol button. (You may have to click the

Symbol

Symbols button first, depending on the size of your screen.)

In Word, Outlook, and Publisher, click More Symbols after you click the
Symbol button if no symbol on the drop-down list does the job for you.
You see the Symbol dialog box (refer to Figure 2-6).
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2. If you’re looking to insert a symbol, not a foreign character, choose
Webdings or Wingdings 1, 2, or 3 in the Font drop-down list.

Webdings and the Wingdings fonts offer all kinds of weird and wacky
symbols.

3. Select a symbol or foreign character.
You may have to scroll to find the one you want.

4. Click the Insert button to enter the symbol and then click Close to
close the dialog box.

<P The Symbol dialog box lists the last several symbols or foreign charac-
ters you entered under Recently Used Symbols. See whether the symbol
you need is listed there. It spares you the trouble of rummaging in the
Symbol dialog box. In Word, Outlook, and Publisher, you see the last
several symbols or foreign characters you entered on a drop-down list
after you click the Symbol button.

Finding and Replacing Text

Use the Find command to locate a name or text passage. Use its twin, the power-
ful Replace command, to find and replace a name or text passage throughout a
file. For an idea of how useful the Replace command is, imagine that the com-
pany you work for just changed its name and the old company name is in many
different places. By using the Replace command, you can replace the old com-
pany name with the new name throughout a long file in a matter of seconds.

The basics: Finding stray words and phrases

To locate stray words, names, text passages, and formats, follow these basic
steps:

34 Find 1. Press Ctrl+F or go to the Home tab and click the Find button. (In
Excel, click the Find & Select button and choose Find on the drop-
down list.)

A dialog box or pane appears so that you can enter search criteria.
Figure 2-7 shows the Find dialog box in PowerPoint and the Find and
Replace dialog box in Excel.

Figure 2'7: Find (7= Find and Replace (7 ==
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52 Creating Hyperlinks
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Click the Replace All button only if you are very, very confident that the
thing your program found is the thing you want to replace.

Be sure to examine your file after you conduct a find-and-replace operation.
You never know what the powerful Replace command will do. If the com-
mand makes a hash of your file, click the Undo button.

Creating Hyperlinks

A hyperlink is an electronic shortcut from one place to another. If you've
spent any time on the Internet, you know what a hyperlink is. Clicking hyper-
links on the Internet takes you to different Web pages or different places on
the same Web page. In the Office programs, you can use hyperlinks to con-
nect readers to your favorite Web pages or to a different page, slide, or file.
You can fashion a link out of a word or phrase as well as any object — a clip-
art image, text box, shape, or picture.

These pages explain how to insert a hyperlink to another place in your file as
well as create links to Web pages. You also discover how to enter an e-mail
hyperlink that makes it easy for others to e-mail you. By the way, the Office
programs create a hyperlink for you automatically when you type a word
that begins with www and ends with .com or .net. The programs create an
automatic e-mail hyperlink when you enter letters that include the symbol
(@) and end in .com or .net.

Linking a hyperlink to a Web page

It could well be that a Web page on the Internet has all the information your
readers need. In that case, you can link to the Web page so that viewers can
visit it in the course of viewing your file. When a viewer clicks the link, a Web
browser opens and the Web page appears.

Follow these steps to hyperlink your file to a Web page on the Internet:

1. Select the text or object that will form the hyperlink.

For example, select a line of text or phrase if you want viewers to be able
to click it to go to a Web page.
g < On the Insert tab, click the Hyperlink button (or press Ctrl+K).
QZOhI b, click the Hyperlink b p Ctrl
RS Depending on the size of your screen, you may have to click the Links
button before you can get to the Hyperlink button. You see the Insert
Hyperlink dialog box, as shown in Figure 2-10. You can also open this
dialog box by right-clicking an object or text and choosing Hyperlink on
the shortcut menu.



Chapter 3: Speed Techniques
Worth Knowing About

In This Chapter

1+ Undoing mistakes and repeating actions

v Zooming to get a better view of your work

1 Working with two different files at the same time
v~ Instructing Office to correct typos automatically

v+ Entering hard-to-type text with the AutoCorrect command

rlis brief chapter takes you on a whirlwind tour of shortcut commands
that can save you time and effort no matter which Office program
you're working in. This chapter is devoted to people who want to get it done
quickly and get away from their computers. It explains the Undo and Repeat
commands, zooming in and out, and opening more than one window on the
same file. You also discover how to display windows in different ways, cor-
rect your typos automatically, and enter hard-to-type terminology with a
simple flick of the wrist.

Undoing and Repeating Commands

If I were to choose two commands for the Hall of Fame, they would be

the Undo command and the Repeat command. One allows you to reverse
actions you regret doing, and the other repeats a previous action without
you having to choose the same commands all over again. Undo and Repeat
are explained forthwith.

Undoing a mistake

Fortunately for you, all is not lost if you make a big blunder because Office
has a marvelous little tool called the Undo command. This command
“remembers” your previous editorial and formatting changes. As long as
you catch your error in time, you can undo your mistake.

) Click the Undo button on the Quick Access toolbar (or press Ctrl+Z) to undo
"'? ¥ your most recent change. If you made your error and went on to do some-
thing else before you caught it, open the drop-down list on the Undo button.
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Zooming In, Zooming Out 59

Eyes weren’t meant to stare at the computer screen all day, which makes
the Zoom controls all the more valuable. You can find these controls in the
lower-right corner of the window and on the View tab, as shown in Figure
3-2. Use them freely and often to enlarge or shrink what is on the screen and
preserve your eyes for important things, such as gazing at the sunset.

Zoom button
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Zoom

Meet the Zoom controls:

4+ Zoom dialog box: Click the Zoom button on the View tab or the Zoom
box (the % listing) to display the Zoom dialog box, as shown in Figure
3-2. From there, you can select an option button or enter a Percent

measurement.

4 Zoom button: Click the Zoom In or Zoom Out button on the Zoom slider
to zoom in or out in 10-percent increments.

4 Zoom slider: Drag the Zoom slider left to shrink or right to enlarge what

is on your scCreern.

4+ Mouse wheel: If your mouse has a wheel, you can hold down the Ctrl
key and spin the wheel to quickly zoom in or out.
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W

Each Office program offers its own special Zoom commands in the Zoom
group on the View tab. In Word, for example, you can display one page or
many pages; in Excel, you can click the Zoom to Selection button and enlarge
a handful of cells. Make friends with the Zoom commands. They never let
you down.

Viewing a File through More Than One Window

By way of the commands in the Window group in the View tab, you can be
two places simultaneously, at least where Office is concerned. You can work
on two files at once. You can place files side by side on the screen and do a
number of other things to make your work a little easier.

1
L

e
Window

Arrange
Al

]
Switch
Wirdaws =

Word, Excel, and PowerPoint offer these buttons in the Window group:

+

<+
<+

New Window: Opens another window on your file so you can be two
places at once in the same file. To go back and forth between windows,
click a taskbar button or click the Switch Windows button and choose a
window name on the drop-down list. Click a window’s Close button
when you're finished looking at it.

Arrange All: Arranges open windows side by side on-screen.

Switch Windows: Opens a drop-down list with open windows so you can
travel between windows.

You can also take advantage of these Window buttons in Word and Excel to
compare files:

+

+

View Side by Side: Displays files side by side so you can compare and
contrast them.

Synchronous Scrolling: Permits you to scroll two files at the same rate so
you can proofread one against the other. To use this command, start by
clicking the View Side by Side button. After you click the Synchronous
Scrolling button, click the Reset Window Position button so both files
are displayed at the same size on-screen.

Reset Window Position: Makes files being shown side by side the same
size on-screen to make them easier to compare.

Correcting Typos on the Fly

The unseen hand of Office 2010 corrects some typos and misspellings
automatically. For example, try typing accomodate with one m — Office
corrects the misspelling and inserts the second m for you. Try typing
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Entering Text Quickly with the AutoCorrect Command >

Figure 3-4:
With a little
cunning,
you can use
AutoCorrect
to enter
hard-to-type
text.

Chapter 3

The preceding part of this chapter explains how you can use the AutoCorrect
command to help correct typing errors, but with a little cunning you can
also use it to quickly enter hard-to-type jargon, scientific names, and the
like. To open the AutoCorrect dialog box, go to the File tab, choose Options,
go to the Proofing category in the Options dialog box, and then click the
AutoCorrect Options button. Select the AutoCorrect tab in the AutoCorrect
dialog box, as shown in Figure 3-4.
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In the Replace column in the AutoCorrect tab are hundreds of common
typing errors and codes that Office corrects automatically. The program cor-
rects the errors by entering text in the With column whenever you mistak-
enly type the letters in the Replace column. However, you can also use this
dialog box for a secondary purpose to quickly enter text.

To make AutoCorrect work as a means of entering text, you tell Office to
enter the text whenever you type three or four specific characters. In Figure
3-4, for example, Office is instructed to insert the words Cordyceps sinensis (a
mushroom genus) whenever [ enter the characters /cs (and press the space-
bar). Follow these steps to use AutoCorrect to enter text:



Chapter 4: Taking Advantage
of the Proofing Tools

In This Chapter

v~ Fixing spelling errors and customizing the spelling dictionary

1 Repairing grammatical errors in Word documents

1+ Conducting outside research while you work in an Office program
1+ Looking for a better word in the thesaurus

1 Working with and translating foreign language text

was going to call this chapter “Foolproofing Your Work,” but that

seemed kind of presumptuous because keeping every error from slipping
into your work is well-nigh impossible. Still, you can do a good job of proof-
ing your work and eliminating errors by using the tools that Office provides
for that purpose. This chapter describes how to proof your work for spell-
ing and grammatical errors. It shows how to conduct research in reference
books and on the Internet without leaving an Office program. You also find
out how to translate text and proof foreign language text in an Office file.
The Office proofing tools are not foolproof, but they're close to it.

Correcting Your Spelling Errors

\NG/
&Q‘“

Office keeps a dictionary in its hip pocket, which is a good thing for you.
Who wants to be embarrassed by a spelling error? Office consults its dic-
tionary when you enter text in Word, PowerPoint, Access, Excel, Outlook,
and Publisher. To correct misspellings, you can either address them one at
a time or start the spell checker and proof many pages or slides simultane-
ously. You can even create your own dictionary with the jargon and slang
peculiar to your way of life and have Office check the spelling of your jargon
and slang.

Don’t trust the smell checker to be accurate all the time. It doesn’t really
locate misspelled words — it locates words that aren’t in its dictionary. For
example, if you write “Nero diddled while Rome burned,” the spell checker
won’t catch the error. Nero fiddled while Rome burned, but because diddle is
a legitimate word in the spelling dictionary, the spell checker overlooks the
error. The moral: Proofread your files carefully and don’t rely on the spell
checker to catch all your smelling errors.



Checking for Grammatical Errors in Word /1
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Figure 4-4:
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words in
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dictionary in
this dialog
box.

Dictionary:

Preventing text from being spell-checked

Spell-checking address lists, lines of computer code, and foreign languages
such as Spanglish for which Microsoft doesn’t offer foreign language diction-
aries is a thorough waste of time. Follow these steps in Word, PowerPoint,
and Outlook to tell the spell checker to ignore text:

1. Select the text.

i 2. In the Review tab, click the Language button and choose Set Proofing
lang'uage Language OIl the dl'Op-dOWIl liSt.

You see the Language dialog box.
3. Select the Do Not Check Spelling or Grammar check box.
4. Click OK.

Checking for Grammatical Errors in Word

Much of what constitutes good grammar is, like beauty, in the eye of the
beholder. Still, you can do your best to repair grammatical errors in Word
documents by getting the assistance of the grammar checker. The grammar
checker identifies grammatical errors, explains what the errors are, and
gives you the opportunity to correct the errors.

489 Figure 4-5 shows the grammar checker in action in the Spelling and Grammar
swanaz dialog box. As long as the Check Grammar check box is selected, Word looks
" for grammatical errors along with spelling errors. To open the Spelling and
Grammar dialog box, press F7 or go to the Review tab and click the Spelling

& Grammar button.
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Figure 4-5:
Fix
grammatical
errors

with the
grammar
checker.
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Sentences in which grammatical errors appear are underlined in blue in your
document. Meanwhile, the grammatical errors themselves appear in bright
blue in the box at the top of the Spelling and Grammar dialog box (along
with spelling errors, which are red). When Word encounters an error, take
one of these actions to correct it:

4+ Select a correction in the Suggestions box and click the Change button.

4 Delete the grammatical error or rephrase the sentence in the top of the
dialog box, enter a correction, and click the Change button.

4 Click outside the Spelling and Grammar dialog box, correct the gram-
matical error in your document, and then click the Resume button (you
find it where the Ignore Once button used to be).

Click one of the Ignore buttons to let what Word thinks is a grammatical
error stand.

If you want to fine-tune how Word runs its grammar checker, click the
Options button in the Spelling and Grammar dialog box. You land in the
Proofing category of the Word Options dialog box. Under When Correcting
Spelling and Grammar in Word, choose whether to underline grammatical
errors in your documents, whether to check for grammatical as well as spell-
ing errors, and in the Writing Style drop-down list, how stringent you want
the rules of grammar to be. Choose Grammar & Style, not Grammar Only, if
you want Word to enforce style rules as well as the rules of grammar.

Researching a Topic Inside an Office Program

Thanks to the Research task pane, your desk needn’t be as crowded as
before. The Research task pane offers dictionaries, foreign language dic-
tionaries, a thesaurus, language translators, and encyclopedias, as well as
Internet searching, all available from inside the Office programs. As shown
in Figure 4-6, the Research task pane can save you a trip to the library. Table 4-1
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3. Enter a research term in the Search For text box (if one isn’t there
already).

If you weren’t able to click a word or select words in Step 1, enter
research terms now.

4. Open the Search For drop-down list and tell Office where to steer your
search (refer to Table 4-1).

Choose a reference book, research Web site, or business and financial
Web site. To research in a category, choose a category name — All
Reference Books, All Research Sites, or All Business and Financial Sites.
Later in this chapter, “Choosing your research options” explains how to
decide which researching options appear on the drop-down list.

5. Click the Start Searching button (or press Enter).

The results of your search appear in the Research task pane.

If your search yields nothing worthwhile or nothing at all, scroll to the
bottom of the task pane, click Can’t Find It?, and try the All Reference Books
or All Research Sites link. The first link searches all reference books — the
dictionaries, thesauruses, and translation services. The second searches
research sites — Bing, Factiva iWorks, and HighBeam Research.

You can retrace a search by clicking the Previous Search button or Next
Search button in the Research task pane. These buttons work like the Back
and Forward buttons in a Web browser.

Choosing your research options

Which research options appear in the Search For drop-down list is up

to you. Maybe you want to dispense with the for-a-fee services. Maybe

you want to get stock quotes from a particular country. To decide which
research options appear in the Research task pane, open the task pane and
click the Research Options link (at the bottom of the task pane). You see
the Research Options dialog box. Select the research services you want and
click OK.

Finding the Right Word with the Thesaurus

If you can’t find the right word or if the word is on the tip of your tongue
but you can’t quite remember it, you can always give the thesaurus a shot.
To find synonyms for a word, start by right-clicking the word and choosing
Synonyms on the shortcut menu, as shown in Figure 4-7 (you can’t do this in
Excel). With luck, the synonym you’re looking for appears on the submenu,
and all you have to do is click to enter the synonym. Usually, however, find-
ing a good synonym is a journey, not a Sunday stroll.
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Proofing Text Written in a Foreign Language 7

Proofing Text Written in a Foreign Language Bookd

Chapter 4

In the interest of cosmopolitanism, Office gives you the opportunity to make
foreign languages a part of Word documents, PowerPoint presentations,
Publisher publications, and Outlook messages. To enter and edit text in a
foreign language, start by installing proofing tools for the language. With the
tools installed, you tell Office where in your file a foreign language is used.
After that, you can spell-check text written in the language.

sjoo] buijooid ayy
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To spell-check text written in Uzbek, Estonian, Afrikaans, and other lan-
guages apart from English, French, and Spanish, you have to obtain addi-
tional proofing tools from Microsoft. These can be obtained at the Microsoft
Product Information Center at www.microsoft.com/products (enter
proofing tools in the Search box). Proofing tools include a spell checker,
grammar checker, thesaurus, hyphenator, AutoCorrect list, and translation
dictionary, but not all these tools are available for every language.

<MBER . . .
In PowerPoint and Word, the status bar along the bottom of the window lists

which language the cursor is in. Glance at the status bar if you aren’t sure

which language Office is whispering in your ear.

Telling Office which languages you will use

Follow these steps to inform Word, PowerPoint, Publisher, and Outlook that
you will use a language or languages besides English in your files:

e 1. On the Review tab, click the Language button and choose Language
lang'uage Pl’efel’ences.
The Options dialog box opens to the Language category.

2. Open the Add Additional Editing Languages drop-down list, select a
language, and click the Add button to make that language a part of
your presentations, documents, and messages.

3. Click OK.

Marking text as foreign language text

The next step is to tell Office where in your file you're using a foreign lan-
guage. After you mark the text as foreign language text, Office can spell-
check it with the proper dictionaries. Follow these steps to mark text so that
Office knows in which language it was written:

1. Select the text that you wrote in a foreign language.

2. Go to the Review tab.
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3. Click the Language button and choose Set Proofing Language on the
drop-down list.

You see the Language dialog box, as shown in Figure 4-8.

4. Select a language and click OK.
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Translating Foreign Language Text

%

Translate

Office offers a gizmo for translating words and phrases from one language to
another. The translation gizmo gives you the opportunity to translate single
words and phrases as well as entire files, although, in my experience, it is
only good for translating words and phrases. To translate an entire file, you
have to seek the help of a real, native speaker.

Follow these steps to translate foreign language text:

1. Select the word or phrase that needs translating.

2. On the Review tab, click the Translate button and choose a Translate
option on the drop-down list.

Office offers these ways to translate words:

e Translate Document (Word only): Word sends the text to a translation
service at Bing Translator, and the translated text appears on a Web
page. Copy the text and do what you will with it. (If the wrong trans-
lation languages are listed, choose the correct languages from the
drop-down lists.)



Chapter 5: Creating a Table

In This Chapter

1+ Understanding table jargon

1 Creating a table and entering the text and numbers

1+~ Aligning table text in various ways

1 Merging and splitting cells to make interesting layouts
1 Changing the size of rows and columns

1 Decorating a table with table styles, colors, and borders
1+ Doing math calculations in a Word table

v Discovering an assortment of table tricks

Fe best way to present a bunch of data at once in Word, PowerPoint, or
Publisher is to do it in a table. Viewers can compare and contrast the
data. They can compare Elvis sightings in different cities or income from
different businesses. They can contrast the number of socks lost in different
washing machine brands. A table is a great way to plead your case or defend
your position. On a PowerPoint slide, the audience can see right away that
the numbers back you up. In a Word or Publisher document, readers can
refer to your table to get the information they need.

As everyone who has worked on tables knows, however, tables are a chore.
Getting all the columns to fit, making columns and rows the right width

and height, and editing the text in a table isn’t easy. This chapter explains
how to create tables, enter text in tables, change the number and size of
columns and rows, lay out tables, format tables, and (in Word) do the math
in tables. You also discover a few tricks — including using a picture for the
background — that only magicians know. And to start you on the right foot,
I begin by explaining table jargon.
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Talking Table Jargon

As with much else in Computerland, tables have their own jargon. Figure 5-1
describes this jargon. Sorry, but you need to catch up on these terms to con-
struct the perfect table:

4 Cell: The box that is formed where a row and column intersect. Each cell
holds one data item.

4 Header row: The name of the labels along the top row that explain what
is in the columns below.

4 Row labels: The labels in the first column that describe what is in
each row.

4 Borders: The lines in the table that define where the rows and
columns are.

4 Gridlines: The gray lines that show where the columns and rows are.
Unless you’'ve drawn borders around all the cells in a table, you can’t tell
where rows and columns begin and end without gridlines. To display or
hide the gridlines, go to the (Table Tools) Layout tab and click the View
Gridlines button.

Row labels Header row
| |

East
West
Figure 5-1:
The parts of North
a table. South

Borders Gridlines Cells

Creating a Table

Word, PowerPoint, and Publisher offer several ways to create a table:

= 4+ Drag on the Table menu. On the Insert tab, click the Table button, point
T in the drop-down list to the number of columns and rows you want,
click, and let go of the mouse button.
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Entering the Text and Numbers

After you create a table, you get two new tabs on the Ribbon. The (Table
Tools) Design tab offers commands for changing the look of the table; the
(Table Tools) Layout tab is for changing around the rows and columns.

Entering the Text and Numbers

a\\J

After you create the table, you can start entering text and numbers. All you
have to do is click in a cell and start typing. Select your table and take advan-
tage of these techniques to make the onerous task of entering table data a
little easier:

4+ Quickly changing a table’s size: Drag the bottom or side of a table to
change its overall size. In Word, you can also go to the (Table Tools)
Layout tab, click the AutoFit button, and choose AutoFit Window to
make the table stretch from margin to margin.

4+ Moving a table: In Word, switch to Print Layout view and drag the table
selector (the square in the upper-left corner of the table). In PowerPoint
and Publisher, move the pointer over the table’s perimeter, and when
you see the four-headed arrow, click and drag.

4+ Choosing your preferred font and font size: Entering table data is
easier when you’re working in a font and font size you like. Select the
table, visit the Home tab, and choose a font and font size there. In Word
and PowerPoint, you can select a table by going to the (Table Tools)
Layout tab, clicking the Select button, and choosing Select Table on the
drop-down list.

4 Quickly inserting a new row: Click in the last column of the last row
in your table and press the Tab key to quickly insert a new row at the
bottom of the table.

Here are some shortcuts for moving the cursor in a table:

Press Moves the Cursor to

Tab Next column in row

Shift+Tab Previous column in row

\2 Row below

T Row above

Alt+Page Up Top of column (Word and PowerPoint)

Alt+Page Down Bottom of column (Word and PowerPoint)
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Selecting Different Parts of a Table

It almost goes without saying, but before you can reformat, alter, or diddle
with table cells, rows, or columns, you have to select them:

Ny

Select

+

+

Selecting cells: To select a cell, click in it. You can select several adja-
cent cells by dragging the pointer over them.

Selecting rows: Move the pointer to the left of the row and click when
you see the right-pointing arrow; click and drag to select several rows.
You can also go to the (Table Tools) Layout tab, click inside the row you
want to select, click the Select button, and choose Select Row on the
drop-down list. To select more than one row at a time, select cells in the
rows before choosing the Select Row command.

Selecting columns: Move the pointer above the column and click when
you see the down-pointing arrow; click and drag to select several col-
umns. You can also start from the (Table Tools) Layout tab, click in the
column you want to select, click the Select button, and choose Select
Column in the drop-down list. To select several columns, select cells in
the columns before choosing the Select Column command.

Selecting a table: On the (Table Tools) Layout tab, click the Select
button, and choose Select Table on the drop-down list. In PowerPoint,
you can also right-click a table and choose Select Table on the shortcut
menu.

Aligning Text in Columns and Row's

<+

Aligning text in columns and rows is a matter of choosing how you want the
text to line up vertically and how you want it to line up horizontally. Select
the cells, columns, or rows, with text that you want to align (or select your
entire table) and then align the text:

In Word and Publisher: On the (Table Tools) Layout tab, click an Align
button (you may have to click the Alignment button first, depending

on the size of your screen). Word offers nine of them in the Alignment
group.

In PowerPoint: On the (Table Tools) Layout tab, click one Horizontal
Align button (Align Left, Center, or Align Right), and one Vertical Align
button (Align Top, Center Vertically, or Align Bottom). You may have to
click the Alignment button first.
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Merging and Splitting Cells

Merge and split cells to make your tables a little more elegant than run-of-
the-mill tables. Merge cells to break down the barriers between cells and join
them into one cell; split cells to divide a single cell into several cells (or sev-
eral cells into several more cells). In the table shown in Figure 5-2, the cells
in rows two, four, and six have been merged and a baseball player’s name
appears in each merged cell. Where rows two, four, and six originally had
nine cells, they now have only one.

Merge and split cells

(W U= = B R
m Home  Insert  Page layout  Referemces  Mgilings.  Reviewr  Wisw  Deweloper | Design Layout | & @
| s select~ | i & msertBelow [ B Merge cens | 53 I EEE A= i a
i View Gridiines f\| J Al msert Lert Mesr W "H=g=2 — J ~
= Delete | Insert Text Cell Data
| B properties v Aboue GlbInsertRight | splitTable | [ autoFit~ =l =l = pirection Margins
Tahle Rows & Columns Merge Cell Size Alignment |
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Select the cells you want to merge or split, go to the (Table Tools) Layout
tab, and follow these instructions to merge or split cells:
—4 4 Merging cells: Click the Merge Cells button (in Word and PowerPoint,
Merge you can also right-click and choose Merge Cells).
—| # Splitting cells: Click the Split Cells button (in Word and PowerPoint, you

Split
Cells

can also right-click and choose Split Cells). In the Split Cells dialog box,

declare how many columns and rows you want to split the cell into and
then click OK. In Publisher, you can only split cells that were previously
merged.

In Word and PowerPoint, you can merge and split cells by clicking the Draw
Table or Eraser button on the (Table Tools) Design tab. Click the Draw Table
button and then draw lines through cells to split them. Click the Eraser
button and drag over or click the boundary between cells to merge cells.
Press Esc when you finish drawing or erasing table cell boundaries. You can
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click the Pen Color button and choose a color on the drop-down list to draw
in a particular color.

Need to split a table? In Word, place the cursor in what you want to be the
first row of the new table, go to the (Table Tools) Layout tab, and click the
Split Table button.

Laying Out Your Table

“

Very likely, you created too many or too few columns or rows for your table.
Some columns are probably too wide and others too narrow. If that’s the
case, you have to change the table layout by deleting, inserting, and chang-
ing the size of columns and rows, not to mention changing the size of the
table itself. In other words, you have to modify the table layout. (Later in this
chapter, “Decorating your table with borders and colors” shows how to put
borders around tables and embellish them in other ways.)

Changing the size of a table, columns, and rows

The fastest way to adjust the width of columns, the height of rows, and the
size of a table itself is to "eyeball it” and drag the mouse:

4 Column or row: Move the pointer onto a gridline or border, and when
the pointer changes into a double-headed arrow, start dragging. Tug and
pull, tug and pull until the column or row is the right size.

In Word and PowerPoint, you can also go to the (Table Tools) Layout
tab and enter measurements in the Height and Width text boxes to
change the width of a column or the height of a row. The measurements
affect entire columns or rows, not individual cells.

4 A table: Select your table and use one of these techniques to change its
size in Word and PowerPoint:

* Dragging: Drag the top, bottom, or side of the table. You can also drag
the lower-right corner to change the size vertically and horizontally.

® Height and Width text boxes: On the (Table Tools) Layout tab, enter
measurements in the Height and Width text boxes. In Publisher,
these text boxes are found on the (Table Tools) Design tab. In
PowerPoint, click the Lock Aspect Ratio check box if you want to
keep the table’s proportions when you change its height or width.

e Table Properties dialog box (Word only): On the (Table Tools) Layout
tab, click the Cell Size group button, and on the Table tab of the
Table Properties dialog box, enter a measurement in the Preferred
Width text box.

Book |
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Formatting Your Table

Moving columns and row's

Because there is no elegant way to move a column or row, you should move
only one at a time. If you try to move several simultaneously, you open a can
of worms that is best left unopened. To move a column or row:

1. Select the column or row you want to move.

Earlier in this chapter, “Selecting Different Parts of a Table” explains
how to select columns and rows.

2. Right-click in the selection and choose Cut on the shortcut menu.
The column or row is moved to the Clipboard.
3. Insert a new column or row where you want the column or row to be.

Earlier in this chapter, “Inserting and deleting columns and rows”
explains how.

4. Move the column or row:

e (Column: Click in the topmost cell in your new column and then click
the Paste button or press Ctrl+V.

e Row: Click in the first column of the row you inserted and then click
the Paste button or press Ctrl+V.

Formatting Your Table

A\\J

After you enter text in the table, lay out the columns and rows, and make
them the right size, the fun begins. Now you can dress up your table and
make it look snazzy. You can change fonts, choose colors for columns and
rows, and even land a graphic in the background of your table. You can also
play with the borders that divide the columns and rows and shade columns,
rows, and cells by filling them with gray shades or a black background. Read
on to find out how to do these tricks.

Designing a table with a table style

The fastest way to get a good-looking table is to select a table style in the
Table Styles gallery, as shown in Figure 5-3. A table style is a ready-made
assortment of colors and border choices. You can save yourself a lot of for-
matting trouble by selecting a table style. After you've selected a table style,
you can modify it by selecting or deselecting check boxes in the Table Style
Options group.
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Selecting colors for columns, rows, or your table
Follow these steps to paint columns, rows, or your table a new color:

1. Select the part of the table that needs a paint job.

i 2. In the (Table Tools) Design tab, open the drop-down list on the
ﬁ - Shading button and choose a color (refer to Figure 5-5).

This button is called Fill in Publisher.

Later in this chapter, “Using a picture as the table background” explains how
to use a picture as the background in a table.

Using Math Formulas in Word Tables

No, you don’t have to add the figures in columns and rows yourself; Word
gladly does that for you. Word can perform other mathematical calculations
as well. Follow these steps to perform mathematical calculations and tell
Word how to format sums and products:

1. Put the cursor in the cell that will hold the sum or product of the cells
above, below, to the right, or to the left.

T 2. On the (Table Tools) Layout tab, click the Formula button.
Depending on the size of your screen, you may have to click the Data
button first. The Formula dialog box appears, as shown in Figure 5-6. In
its wisdom, Word makes an educated guess about what you want the
formula to do and places a formula in the Formula box.
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Units Sold Price Unit ($) Total Sale
13 17812 82,315.56
15 179.33 §2,689.95
93 178.00 $16,554.00
31 67113
F iz Formula [T ]es)
g

6313 Formula:

11 79.40 =PRODLICT{LEFT)
196 $1.766.23 Number format:
#,#20.00 [=]

Figure 5-6:
A math
formulain a
table.

3. If this isn’t the formula you want, delete everything except the equal
sign in the Formula box, open the Paste Function drop-down list, and
choose another function for the formula.

For example, choose PRODUCT to multiply figures. You may have to
type left, right, above, or below in the parentheses within the formula
to tell Word where the figures that you want it to compute are.

4. In the Number Format drop-down list, choose a format for your
number.

5. Click OK.

<P Word doesn’t calculate blank cells in formulas. Enter 0 in blank cells if

you want them to be included in calculations. You can copy functions from
one cell to another to save yourself the trouble of opening the Formula
dialog box.

Neat Table Tricks

The rest of this chapter details a handful of neat table tricks to make your
tables stand out in a crowd. Why should all tables look alike? Read on to
discover how to make text in the header row stand on its ear, put a picture
behind a table, draw diagonal border lines, draw on top of a table, and wrap
slide text around a table.

Changing the direction of header row text

In a top-heavy table in which the cells in the first row contain text and the
cells below contain numbers, consider changing the direction of the text in
the first row to make the table easier to read. Changing text direction in the
first row is also a good way to squeeze more columns onto a table. Consider
how wide the table shown in Figure 5-7 would be if the words in the first row
were displayed horizontally.

Book |
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Chapter 6: Creating a Chart

In This Chapter

1+ Looking at the different parts of a chart

1 Creating a chart

1+ Examining the different types of charts

v Entering chart data in an Excel worksheet

1 Positioning a chart in Excel, Word, and PowerPoint

v Changing the appearance of a chart

1 Saving a customized chart as a template so that you can use it again
v Exploring some fancy-schmancy chart tricks

v Fixing common problems with charts

Nothing is more persuasive than a chart. The bars, pie slices, lines, or
columns show instantaneously that production is up or down, that
cats are better than dogs or dogs better than cats, or that catsup tastes
better than ketchup. Fans of charts and graphs will be glad to know that put-
ting a chart in a Word document, Excel worksheet, or PowerPoint slide is
fairly easy.

This chapter explains how to create a chart. It looks at which charts are
best for presenting different kinds of data, how to change a chart’s appear-
ance, and how to save charts in a template that you can use again. You
discover some nice chart tricks, including how to make a picture the back-
drop for a chart and how to annotate a chart. This chapter also addresses
common chart problems.

A Mercifully Brief Anatomy Lesson

Throughout this chapter, I show you many ways to tinker with charts, but
before you can begin tinkering, you need to know what you’re tinkering
with. In other words, you have to know what the different parts of a chart
are. Here is a brief chart anatomy lesson. Figure 6-1 points out where some
of the terms described here are found on a real, live chart:
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4 Data series: A group of related data points presented by category on a Book |
chart. The chart in Figure 6-1 has two data series, one for Texas and one Chapter 6
for Utah.

4+ Categories: The actual items that you want to compare or display in
your chart. In Figure 6-1, the categories are the three years in which UFO
sightings occurred in the two states.

4+ Legend: A text box located to the side, top, or bottom of a chart that
identifies the chart’s data labels.

ey e buneas)

4+ Horizontal and vertical axes: For plotting purposes, one side of the plot
area. In the chart in Figure 6-1, UFO sightings are plotted on the horizon-
tal axis, categories are plotted on the vertical axis. Sometimes these axes
are called the category axis (or x axis) and the value axis (or y axis).

Axes can be confusing, but these axes aren’t as evil as they seem. All you
really need to know about them is this: You can label the axes in differ-
ent ways and you can rotate the chart so that the horizontal becomes
the vertical axis and vice versa (click the Switch Row/Column button).

4+ Data point: A value plotted on a chart that is represented by a column,
line, bar, pie slice, dot, or other shape. Each data point corresponds to
a value entered in the worksheet. In Figure 6-1, for example, the data
points for Texas UFO sightings are 14 in 2005, 11 in 2006, and 9 in 2007.
Hence the Texas columns in the table rise to the 14, 11, and 9 level.

4 Data marker: Shapes on a chart that represent data points. Data mark-
ers include columns, lines, pie slices, bubbles, and dots. In Figure 6-1,
columns are the data markers.

4+ Data label: A label that shows the actual values used to construct the
data markers. In the chart in Figure 6-1, there are six data labels, one on
the top of each column. Displaying data labels in charts is optional.

The good news where the anatomy of a chart is concerned is that you can
click anywhere on a chart and see a pop-up box that tells you what part of
the chart you just clicked. [ wish biology class were that easy!

WMBER
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The Basics: Creating a Chart

Throughout this chapter, I explain the whys, wherefores, and whatnots
of creating a chart. Before going into details, here are the basic steps that
everyone needs to know to create a chart in Word, Excel, and PowerPoint:

1. Go to the Insert tab.

2. If you’re working in Excel, select the data you’ll use to generate the
chart (in Word and PowerPoint, skip to Step 3).
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4. In Word and PowerPoint, replace the sample data in the Excel work-
sheet with the data you need for generating your chart.

Later in this chapter, “Providing the Raw Data for Your Chart” explains
how to enter data in an Excel worksheet. After you finish entering the
data, you can close Excel by clicking the Close button in the Excel
window or going to the File tab and choosing Close.

5. To modify your chart, start by selecting it.

Click a chart to select it. Selecting a chart makes the Chart Tools tabs
appear in the upper-right corner of the window. Use these tabs —
Design, Layout, and Format — to make your chart just-so.

In Word, you must be in Print Layout view to see a chart.

6. Select the (Chart Tools) Design tab when you want to change the
chart’s layout, alter the data with which the chart was generated, or
select a different chart type.

Later in this chapter, “Changing a Chart’s Appearance” explains how to
change the design of a chart.

7. Select the (Chart Tools) Layout tab when you want to change the
chart’s title, labels, or gridlines.

You can add or remove parts of a chart starting on the Layout tab.
Later in this chapter, “Changing the layout of a chart” describes how to
change around the text and gridlines on a chart.

8. Select the (Chart Tools) Format tab when you want to change the
appearance of your chart.

You can change colors and fills on your chart, as “Changing a chart ele-
ment’s color, font, or other particular” explains later in this chapter.

And if you decide to delete the chart you created? Click its perimeter to
select it and then press the Delete key.

Choosing the Right Chart

If you're a fan of charts, the huge selection of charts can make you feel like a
kid in a candy store, but if charts aren’t your forte, the wealth of charts you
can choose from can be daunting. You can choose among 6 dozen charts in
11 categories (refer to Figure 6-3). Which chart is best? The golden rule for
choosing a chart type is to choose the one that presents information in the
brightest possible light. The purpose of a chart is to compare information
across different categories. Select a chart that draws out the comparison so
that others can clearly make comparisons. Table 6-1 describes the 11 chart
categories and explains in brief when to use each type of chart.

Book |
Chapter 6
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Providing the Raw Data for Your Chart

<MBER
S

Diata
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Edit:

Every chart is constructed from raw data — the numbers and category
names you select in an Excel worksheet (in Excel) or enter in an Excel work-
sheet (in Word and PowerPoint). If you're operating in Word or PowerPoint,
you see, in the Excel worksheet, sample data in a data range. The informa-
tion inside the data range is used to generate the chart. You can tell where
the data range begins and ends because it is enclosed in a blue border. Your
job is to replace the sample data in the data range with data of your own. As
you enter your data, the chart on your slide or page takes shape.

Book V, Chapter 1 explains in detail how to enter data in an Excel worksheet,
but here are the basics of entering data in case you're new to Excel:

4+ Entering the data in a cell: A cell is the box in a worksheet where a
column and row intersect; each cell can contain one data item. To
enter data in a cell, click the cell and start typing. When you're finished,
press Enter, press Tab, or click a different cell. You can also click in the
Formula bar (above the worksheet) and enter the data there.

4+ Deleting the data in a cell: To delete the data in a cell, including the
sample data Excel provides for charts, click the cell and press Delete.

4+ Displaying the numbers: When a number is too large to fit in a cell,
Excel displays pound signs (###) or displays the number in scientific
notation. Don’t worry — the number is still recorded and is used to
generate your chart. You can display large numbers by widening the
columns in which the numbers are found. Move the pointer between
column letters (A, B, and so on at the top of the worksheet) and when
you see the double-headed arrow, click and drag to the right.

To enclose more or fewer cells in the data range, move the pointer to the
lower-right corner of the data range, and when the pointer changes into a
two-headed arrow, click and drag so that the blue box encloses only the data
you want for your chart.

In Word and PowerPoint, click the Edit Data button on the (Chart Tools)
Design tab at any time to open Excel and fiddle with the numbers and data
from which your chart is generated.

Positioning Your Chart in a Workbook, Page, or Slide

To change the position of a chart, click to select it, click its perimeter, and
when you see the four-headed arrow, start dragging. Otherwise, follow these
instructions to land your chart where you want it to be:

Book |
Chapter 6
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]
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Chart
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4 Excel: To move your chart to a different worksheet or create a new

worksheet to hold your chart, go to the (Chart Tools) Design tab and
click the Move Chart button. You see the Move Chart dialog box.

e To move your chart to a different worksheet, click the Object In
option button, choose the worksheet in the drop-down list, and
click OK.

e To create a new worksheet for a chart, click the New Sheet option
button, enter a name for the new worksheet, and click OK.

4+ Word: Starting in Print Layout view, select your chart, and in the Page

Layout or (Chart Tools) Format tab, click the Position button (you may
have to click the Arrange button first, depending on the size of your
screen). You see a drop-down list with text-wrapping options. Choose
the option that describes how you want surrounding text to behave
when it crashes into your chart. Book II, Chapter 4 looks in detail at
wrapping text around charts and other objects in Word.

4+ PowerPoint: Select the chart and drag it on the slide to the right position.

Changing a Chart’s Appearance

Charts are awfully nice already, but perhaps you want to redesign one.
Perhaps you're an interior decorator type and you want to give charts your
own personal touch. Excel, PowerPoint, and Word offer these Chart Tools
tabs for redecorating charts:

4+ Design tab: For quickly changing a chart’s appearance. Go to the Design

tab if you're in a hurry. The ready-made gallery choices give you the
opportunity to change a chart’s layout and appearance in a matter of
seconds. You can also choose a new chart type from the Design tab. See
“Relying on a chart style to change appearances,” later in this chapter.

Layout tab: For rearranging, hiding, and displaying various parts of a
chart, including the legend, labels, title, gridlines, and scale. Go to the
Layout tab to tweak your chart and make different parts of it stand out
or recede into the background. For example, you can display axis labels
more prominently or make them disappear, enter a title for your chart,
or display more or fewer gridlines. See “Changing the layout of a chart”
and “Handling the gridlines,” later in this chapter.

Format tab: For changing the color, outline, font, and font size of various
parts of a chart, including the labels, bars, and pie slices. You have to
really know what you’re doing and have a lot of time on your hands to
change colors and fonts throughout a chart. See “Changing a chart ele-
ment’s color, font, or other particular,” later in this chapter.
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The (Chart Tools) Layout tab also offers these convenient commands for
changing the color of a chart element:
1| ¢ Plotarea: The plot area is the rectangle in which the chart’s gridlines, bars,
ot columns, pie slices, or lines appear. In some chart designs, the plot area is

filled with color. To remove this color or choose a different color, click the
Plot Area button and choose an option. Choose More Plot Area Options to
open the Format Plot Area dialog box and select a new fill color.

4 3D chart wall and chart floor: Three-dimensional charts have chart walls
and a chart floor. The chart wall forms the backdrop of a 3-D chart; the chart
floor forms the bottom of the chart. Click the Chart Wall button and choose
an option to remove the chart wall or change its color; click the Chart Floor
button and choose an option to remove the chart floor or change its color.

Saving a Chart as a Template So
That You Can Use It Again

If you go to the significant trouble of redecorating a chart and you expect to
do it again the same way in the future, save your chart as a template. This
way, you can call on the template in the future to create the same chart

and not have to decorate it again. Perhaps you've created charts with your
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company’s colors or you've created a chart that you're especially proud of. Book |
Save it as a template to spare yourself the work of reconstructing it. Chapter 6

A chart template holds data series colors, gridline settings, plot area colors, font
settings, and the like. It doesn’t hold data. These pages explain how to save a
chart as a template and how to create a chart with a template you created.

ey e buneas)

Saving a chart as a template

Follow these steps to make a template out of a chart:
1. Save your file to make sure that the chart settings are saved on your
computer.
2. Select your chart.
Go to the (Chart Tools) Design tab.

W

i, 4. Click the Save As Template button.

Famplate You can find this button in the Type group. You see the Save Chart
Template dialog box.

5. Enter a descriptive name for the template and click the Save button.

Include the type of chart you're dealing with in the name. This will help
you understand which template you're selecting when the time comes to
choose a chart template.

By default, chart templates are saved in this folder in Windows 7 and
Windows Vista: C: \Users\Username\AppData\Roaming\Microsoft\
Templates\Charts. Chart templates are stored in this folder in Windows
XP: C:\Documents and Settings\Username\Application Data\
Microsoft\Templates\Charts. The templates have the . ctrx exten-
sion. If you want to delete or rename a template, open the Charts folder

in Windows Explorer or Computer and do your deleting and renaming
there. You can open the Charts folder very quickly by clicking the Manage
Templates button in the Insert Chart dialog box (refer to Figure 6-3).

Creating a chart from a template

To create a chart from your own customized template, open the Create

Chart dialog box (click the Chart button) and go to the Templates category.
The dialog box shows a list of templates you created. Move the pointer over
a template to read its name in a pop-up box. Select a template and click OK.

Chart Tricks for the Daring and Heroic

This chapter wouldn’t be complete without a handful of chart tricks to
impress your friends and intimidate your enemies. In the pages that follow,
you discover how to make charts roll over and play dead. You also find out
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= 2. Click the Trendline button and choose a trendline option on the drop-

Trendline

down list.

You can choose More Trendline Options on the drop-down list to open the
Format Trendline dialog box and choose additional types of trendlines.

To change the look of a trendline, right-click it and choose Format
Trendline. In the Format Trendline dialog box, choose a line color and
line style.

To remove a trendline from a chart, go to the (Chart Tools) Layout tab, click
the Trendline button, and choose None on the drop-down list.

Troubleshooting a Chart

Sometimes tinkering with a chart opens a Pandora’s box of problems. You
find yourself having to correct little errors that appear in charts. Here are
some shorthand instructions for fixing common chart problems:

4 The dates in the chart aren’t formatted right. To change the way in

which dates are formatted on a chart, go to the (Chart Tools) Format
tab, open the Chart Elements drop-down list, and choose Horizontal
(Value) Axis or Vertical (Value) Axis. Then click the Format Selection
button, and in the Format Axis dialog box, go to the Number category,
select Date in the Category menu, and choose a date format.

The numbers in the chart aren’t formatted right. To change the
number of decimal places, include comma separators in numbers, dis-
play currency symbols, or do all else that pertains to numbers, go to the
(Chart Tools) Format tab, open the Chart Elements drop-down list, and
choose Horizontal (Value) Axis or Vertical (Value) Axis. Then click the
Format Selection button. You see the Format Axis dialog box. Visit the
Number category and select options for displaying numbers.

“Category 1” or “Series 1” appears in the chart legend. To direct you
to the right place to enter data in Excel worksheets, phantom names
such as “Category 1” and “Series 1” appear in worksheets. Sometimes
these phantoms wind up in chart legends as well. To remove them, go

to the (Chart Tools) Design tab and click the Edit Data button. You see
the Excel worksheet, where the data range used to generate the chart is
enclosed in a blue box. Drag the lower-right corner of the box so that the
box encloses only the data you want for your chart.



Chapter 7: Making a
SmartArt Diagram

In This Chapter

+” Creating a diagram

1 Repositioning and resizing diagrams

1 Laying out and changing the look of diagram shapes
1+ Entering text on a diagram shape

v Changing the appearance of a diagram

1+ Creating a diagram from shapes

A long with charts and tables, diagrams are the best way to present your
ideas. Diagrams clearly show, for example, employees’ relationships
with one another, product cycles, workflow processes, and spheres of influ-
ence. A diagram is an excellent marriage of images and words. Diagrams
allow an audience to literally visualize a concept, idea, or relationship.

This chapter explains how to construct diagrams from SmartArt graphics
and how to create a diagram. It shows how to customize diagrams by chang-
ing the size of diagrams and diagram shapes, adding and removing shapes,
and changing shapes’ colors. You also discover how to change the direction
of a diagram and enter the text. Finally, this chapter demonstrates how to
create a diagram from scratch with shapes and connectors.

The Basics: Creating SmartArt Diagrams

In Word, PowerPoint, and Excel, diagrams are made from SmartArt graphics.
These diagram graphics are “interactive” in the sense that you can move,
alter, and write text on them. In other words, you can use them to construct
diagrams. You can alter these diagrams to your liking. You can make a dia-
gram portray precisely what you want it to portray, although you usually
have to wrestle with the diagram a bit.

The first step in creating a diagram is to select a layout in the Choose a
SmartArt Graphic dialog box, shown in Figure 7-1. After you create the initial
diagram, you customize it to create a diagram of your own. About 120 dia-
grams are in the dialog box. They fall into these eight categories:
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After you select a generic diagram in the Choose a SmartArt Graphic dialog Book |

box and click OK, the next step is to make the diagram your own by complet- Chapter 7
ing these tasks:

s
4+ Change the diagram’s size and position: Change the size and position =
of a diagram to make it fit squarely on your page or slide. See “Changing gé
the Size and Position of a Diagram,” later in this chapter. g :,’,
4 Add shapes to (or remove shapes from) the diagram: Adding a shape 3 §
involves declaring where to add the shape, promoting or demoting the g

shape with respect to other shapes, and declaring how the new shape
connects to another shape. See “Laying Out the Diagram Shapes,” later
in this chapter.

4+ Enter text: Enter text on each shape, or component, of the diagram. See
“Handling the Text on Diagram Shapes,” later in this chapter.

If you so desire, you can also customize your diagram by taking on some or
all of these tasks:

4+ Changing its overall appearance: Choose a different color scheme or
3-D variation for your diagram. See “Choosing a Look for Your Diagram,”
later in this chapter.

4+ Changing shapes: Select a new shape for part of your diagram, change
the size of a shape, or assign different colors to shapes to make shapes
stand out. See “Changing the Appearance of Diagram Shapes,” later in
this chapter.

If you're comfortable creating a diagram of your own by drawing shapes and
lines, no law says that you have to begin in the Choose a SmartArt Graphic
dialog box. Later in this chapter, “Creating a Diagram from Scratch” looks
into creating a diagram by making use of text boxes, lines, and shapes.

Creating the Initial Diagram

The first step in fashioning a diagram is to choose a SmartArt graphic in the
Choose a SmartArt Graphic dialog box. After that, you roll up your sleeves,
change the diagram’s size and shape, and enter the text. If you select the
wrong diagram to start with, all is not lost. You can choose another diagram
in its place, although how successful swapping one diagram for another is
depends on how lucky you are and how far along you are in creating your
diagram. These pages explain how to create an initial diagram and swap one
diagram for another.
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are in creating your diagram and whether your diagram is simple or com- Book |
plex. Follow these steps to swap one diagram for another: Chapter 7
1. Click your diagram to select it. =
2. Go to the (SmartArt Tools) Design tab. 9.5

QD

3. Open the Layouts gallery (you may have to click the Change Layout 3 :,’,
button first). 3 3
=
You see a gallery with diagrams of the same type as the diagram you're g

working with.

4. Select a new diagram or choose More Layouts to open the Choose a
SmartArt Graphic dialog box and select a diagram there.

You may have to click the trusty Undo button and start all over if the dia-
gram you selected for the swap didn’t do the job.

Changing the Size and Position of a Diagram

To make a diagram fit squarely on a page or slide, you have to change its
size and position. Resizing and positioning diagrams and other objects is the
subject of Book I, Chapter 8, but in case you don’t care to travel that far to
get instructions, here are shorthand instructions for resizing and positioning
diagrams:

{1+ + Resizing a diagram: Select the diagram, move the pointer over a selec-
tion handle on the corner or side, and start dragging after the pointer
changes into a two-headed arrow. You can also go to the (SmartArt
Tools) Format tab and enter new measurements in the Width and Height
boxes. (You may have to click the Size button to see these text boxes,
depending on the size of your screen.)

4+ Repositioning a diagram: Select the diagram, move the pointer over its
perimeter, and when you see the four-headed arrow, click and start
dragging.

Notice when you resize a diagram that the shapes in the diagram change
size proportionally. Most diagrams are designed so that shapes fill out the
diagram. When you change the size of a diagram, remove a shape from a dia-
gram, or add a shape, shapes change size within the diagram.

Laying Out the Diagram Shapes

At the heart of every diagram are the rectangles, circles, arrows, and what-
nots that make the diagram what it is. These shapes illustrate the concept
or idea you want to express to your audience. Your biggest challenge when
creating a diagram is laying out the diagram shapes.
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Handling the Text on Diagram Shapes

Text
Pane

Figure 7-7:
Type
directly on
diagram
shapes (top)
or enter
text on the
Text pane
(bottom).

When you create a new diagram, “[Text]” (the word Text enclosed in brack-
ets) appears on shapes. Your job is to replace this generic placeholder with
something more meaningful and less bland. These sections explain how to
enter text and bulleted lists on shapes.

Entering text on a diagram shape

Use one of these techniques to enter text on a diagram shape:
4+ Click in the shape and start typing: The words you type appear in the
shape, as shown in Figure 7-7.

4+ Enter text in the Text pane: Enter the text by typing it in the Text pane,
as shown in Figure 7-7. The text pane opens to the left of the diagram. To
open the text pane:

¢ On the (SmartArt Tools) Design tab, click the Text Pane button.

e (lick the Text Pane button on the diagram. This button is not
labeled, but you can find it to the left of the diagram.

—| High Flyer

, — Live Wire

—f [Text]

Type your text here 2|/

e + High Flyer

* Live Wire
® [Text]

- Live Wire

- [Text]

Yertical Box List...




Changing a Diagram’s Direction ’3 /

Book |

- - - = - Chapter 7
Turning a bulleted list into a diagram (PowerPoint)
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Suppose you're working along in PowerPoint 1. Select the text frame or text box. =L

when suddenly the realization strikes you that . =¥}

a bulleted list in a text frame or text box would e e a, Hlll f B e ao

. SmartArt button. s ¥

work much better as a diagram. For those 5 3

occasions, you click the Convert to SmartArt You see a drop-down list with basic dia- 2

button. By clicking this button, you can turn the gram choices. E

text in a text frame or text box into a diagram.
If the text frame or box contains a bulleted list,
each bulleted item becomes a diagram shape.

3. Either select a diagram on the list or
choose More SmartArt Graphics to open
the Choose a SmartArt Graphic dialog box

Follow these steps to turn a text frame or text and select a diagram there.

box into a diagram:

The text in diagrams shrinks as you enter more text so that all text is the
same size. If you want to make the text larger or smaller in one shape, see
“Changing fonts and font sizes on shapes,” later in this chapter.

Entering bulleted lists on diagram shapes

Some diagram shapes have built-in bulleted lists, but no matter. Whether a
shape is prepared to be bulleted or not, you can enter bullets in a diagram
shape. Here are instructions for entering and removing bullets:

-1 4+ Entering a bulleted list: Select the shape that needs bullets, and on the

A (SmartArt Tools) Design tab, click the Add Bullet button. Either enter

o the bulleted items directly into the shape (pressing Enter as you type
each entry) or click the Text Pane button to open the Text pane (refer to
Figure 7-7) and enter bullets there.

4+ Removing bulleted items: Click before the first bulleted entry and keep
pressing the Delete key until you have removed all the bulleted items.
You can also start in the Text pane (refer to Figure 7-7) and press the
Delete key there until you've removed the bulleted items, or drag to
select several bulleted items and then press Delete.

Changing a Diagram’s Direction

As long as your diagram is horizontally oriented, you can change its direc-
tion. As shown in Figure 7-8, you can flip it over such that the rightmost
shape in your diagram becomes the leftmost shape, and what was the left-
most shape becomes the rightmost shape. If arrows are in your diagram, the
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arrows point the opposite direction after you flip the diagram. You can’t flip
vertically oriented diagrams this way. Sorry, but diagrams that run north to
south, not west to east, can’t be rolled over.

—

Figure 7-8:

You can flip

horizontal Input Throughput
diagrams so

that they run
the opposite
direction.

Follow these steps to flip a horizontally oriented diagram:

1. Select the diagram.
(2 Right to Left 2. On the (SmartArt Tools) Design tab, click the Right to Left button.

If you don’t like what you see, click the button again or click the Undo
button.

Choosing a Look for Your Diagram

Decide how a diagram looks by starting on the (SmartArt Tools) Design tab.
Starting there, you can choose a color scheme for your diagram and a differ-
ent style. Between the Change Colors drop-down list and the SmartArt Styles
gallery, you can find a combination of options that presents your diagram in
the best light:

-~ 4 Change Colors button: Click the Change Colors button to see color

hange schemes for your diagram on the drop-down list, as shown in Figure 7-9.
Point at a few options to live-preview them.

4+ SmartArt Styles gallery: Open the SmartArt Styles gallery to choose
simple and 3-D variations on the diagram.
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et button on the (SmartArt Tools) Design tab. Clicking this button reverses all
™" the formatting changes you made to your diagram.

)5 If you experiment too freely and want to backpedal, click the Reset Graphic

<P If your Word document, Excel worksheet, or PowerPoint presentation
includes many diagrams, make sure that your diagrams are consistent in
appearance. Choose similar colors for diagrams. If you like 3-D diagrams,
make the majority of your diagrams 3-D. Don’t let the diagrams overwhelm
the ideas they are meant to express. The point is to present ideas in dia-
grams, not turn your work into a SmartArt diagram showcase.

Changing the Appearance of Diagram Shapes

To call attention to one part of a diagram, you can change the appearance of
a shape and make it stand out. Any part of a diagram that is different from
the other parts naturally gets more attention. To change the appearance

of a shape, consider changing its size or color, exchanging one shape for
another, or changing the font and font size of the text. These topics are cov-
ered in the following pages.
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Changing fonts and font sizes on shapes

To make a diagram shape stand out, try changing the font and font size of
the text on the shape. Before you change fonts and font sizes, however,
you should know that changing fonts in a shape effectively disconnects

the shape from the other shapes in the diagram. Normally, text changes
size throughout a diagram when you add or remove shapes, but when you
change the font or font size in one shape, it is no longer associated with the
other shapes; its letters don’t change their size or appearance when shapes
are added or removed from the diagram of which it is a part.

To alter the text on a diagram shape, select the text, go to the Home tab, and
choose a different font, font size, and font color, too, if you want.

Creating a Diagram from Scratch

Figure 7-12:

A
homegrown
diagram
made
without
SmartArt
graphics.

If you have the skill and the wherewithal, you can create a diagram from
scratch by piecing together shapes, arrows, and connectors. The diagram
in Figure 7-12, for example, was made not from SmartArt graphics but from
shapes, arrows, and connectors. Book I, Chapter 8 explains how to draw
shapes and lines between shapes. You can enter text on any shape merely
by clicking inside it and wiggling your fingers over the keyboard.

Begin Your Search H

Narrow
Your
Search

Do You Know a
Related Term?

'4

Add the Term

v
Enter

Another Start All Over
Search

Term

Making a diagram from scratch has some advantages. You can draw the con-
nectors any which way. Lines can cross the diagram chaotically. You can
include text boxes as well as shapes (the diagram in Figure 7-12 has four text
boxes). Don’t hesitate to fashion your own diagrams when a presentation or
document calls for it.



Chapter 8: Drawing and
Manipulating Lines, Shapes,
and Other Objects

In This Chapter

v+ Drawing and manipulating lines, arrows, and connectors
v Creating and modifying shapes
1 Creating WordArt images

1 Selecting, resizing, moving, aligning, overlapping, rotating, and group-
ing objects

v Changing the color and border around an object

Whether you know it or not, Office 2010 comes with drawing com-
mands for drawing lines, arrows, shapes, block arrows, stars, ban-

ners, and callout shapes. And Office provides numerous ways to manipulate
these objects after you draw them. The drawing commands are meant to
bring out the artist in you. Use them to make diagrams, fashion your own
ideagrams, and illustrate difficult concepts and ideas. Lines and shapes give
you a wonderful opportunity to exercise your creativity. A picture is worth a
thousand words, so they say, and the drawing commands give you a chance
to express yourself without having to write a thousand words.

In this chapter, you discover all the many ways to manipulate lines, shapes,
text boxes, WordArt images, clip-art images, and graphics. You discover
how to lay out these objects on a page or slide, flip them, change their
colors, resize them, move them, and otherwise torture them until they

look just right. You discover how to draw lines and arrows, draw connec-
tions between shapes, and draw ovals, squares, other shapes, and WordArt
images. Use the techniques I describe in this chapter to bring something
more to your Word documents, PowerPoint presentations, Publisher publi-
cations, and Excel worksheets: originality. With the techniques I describe in
this chapter, you can bring the visual element into your work. You can com-
municate with images as well as words and numbers.

The Basics: Drawing Lines, Arrows, and Shapes

Figure 8-1 demonstrates how you can use lines, arrows, and shapes (not
to mention text boxes) to illustrate ideas and concepts. Sometimes, saying
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Shapes gallery for creating new shapes to go along with the one you
created.

Handling Lines, Arrows, and Connectors

Earlier in this chapter, Figure 8-1 shows examples of how you can use lines
and arrows to present ideas. As well as lines and arrows, the Insert Shapes
gallery offers connectors, the special lines that link shapes and can bend and
stretch as you move shapes around. Use connectors along with lines and
arrows to describe the relationships between the people or things in a dia-
gram. These pages explain how to handle lines, arrows, and connectors.

Changing the length and position of a line or arrow

To change anything about a line or arrow, start by clicking to select it. You
can tell when a line has been selected because round selection handles
appear at either end. Follow these instructions to move a line or adjust its
length or angle:

4+ Changing the angle of a line: Drag a selection handle up, down, or side-
ways. A dotted line shows where your line will be when you release the
mouse button.

4+ Changing the length: Drag a selection handle away from or toward the
opposite selection handle.
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If your connector is attached to the wrong shape, don’t despair. Select the
connector, and on the (Drawing Tools) Format tab, click the Edit Shape
button and choose Reroute Connectors. Then move the pointer over the red
handle on the side of the connector that needs to be attached elsewhere,
click, drag the connector elsewhere on the other shape, and release the
mouse button when you see the red selection handles.

Adjusting a connector

Chances are, your connector needs adjusting to make it fit correctly between
the two shapes. Click to select your connector and follow these techniques
to adjust it:

4+ Changing the shape of a connector: Drag the yellow diamond on the
connector. As you drag, the connector assumes different shapes.

4+ Changing the connector type: Right-click the connector, choose
Connector Types, and choose Straight Connector, Elbow Connector, or
Curved Connector on the submenu.

4+ Handling arrows on connectors: If the arrows on the connector aren’t
there, are pointing in the wrong direction, or shouldn’t be there, change
the arrowheads around using the same techniques you use with stan-
dard arrows. See “Attaching and handling arrowheads on lines and con-
nectors,” earlier in this chapter.

Make sure that the connector lines in your diagram are consistent with one
another. Give them the same style and appearance, or else it will be hard to
make sense of your diagram.

Handling Rectangles, Ovals, Stars, and Other Shapes

\NG/
Vg&\

Figure 8-5 illustrates how shapes can come in very handy for illustrating con-
cepts and ideas. You can combine shapes to make your own illustrations.
Apart from the standard rectangle and oval, you can draw octagons and vari-
ous other “-agons,” arrows, stars, and banners. You are hereby encouraged
to make shapes a part of your work, and you’ll be glad to know that drawing
shapes is not difficult. These pages explain how to draw a shape, exchange
one shape for another, change a shape’s symmetry, and enter words on a
shape.

In Word, you must be in Print Layout view to draw and handle shapes. If you
intend to draw more than one shape in Word, create a drawing canvas to
hold the shapes (click the Shapes button and choose New Drawing Canvas).
Book II, Chapter 4 describes the drawing canvas in Word.
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Figure 8-7:
Shapes can
do double
duty as text
boxes.

4+ Allowing the shape to enlarge for text: You can allow the shape to
enlarge and receive more text. Click the Shape Styles group button,
and in the Text Box category of the Format Shape dialog box, select the

Resize Shape to Fit Text option button.
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WordArt for Bending, Spindling, and Mutilating Text

A WordArt image consists of a word that has been stretched, crumpled, or
squeezed into an odd shape. Actually, a WordArt image can include more
than one word. Figure 8-8 shows the WordArt gallery, where WordArt images
are made, and an example of a WordArt image. After you insert a WordArt
image, you can fool with the buttons on the WordArt toolbar and torture the

Figure 8-8:
Creating a
WordArt
image.

word or phrase even further.
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o To apply color or an outline to some of the letters or words in a WordArt

image, select the letters or words before choosing options on the (Drawing
Tools) Format tab.

Manipulating Lines, Shapes, Art,
Text Boxes, and Other Objects

After you insert a shape, line, text box, clip-art image, graphic, diagram,
WordArt image, chart, or embedded object in a file, it ceases being what it
was before and becomes an object. Figure 8-9 shows eight objects. I'm not
sure whether these eight objects resent being objectified, but Office objecti-
fies them. As far as manipulating these items in Office is concerned, these
are just objects.
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The techniques for manipulating objects are the same whether you're deal-
ing with a line, shape, graphic, clip-art image, diagram, or text box. The good
news from your end is that you have to master only one set of techniques
for handling these objects. Whether you want to move, change the size of, or
change the outline of a text box, clip-art image, graphic, or shape, the tech-
niques are the same.

In the remainder of this chapter are instructions for doing these tasks with
objects:

4+ Selecting: Before you can do anything to objects, you have to select
them. See “Selecting objects so that you can manipulate them,” later in
this chapter.

4+ Making use of the rulers and grid: Rulers (in Word, PowerPoint, Excel,
and Publisher) and the grid (in Word and PowerPoint) can be very help-
ful for aligning and placing objects. See “Hiding and displaying the rulers
and grid.”
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Changing an Object’s Color, Outline
Color, and Transparency

If an object’s color or outline color doesn’t suit you, you have the right to
change colors. For that matter, you can opt for a “blank” object with no
color or remove the color from around the perimeter of the object. As the
saying goes, “It’s a free country.”

Office has its own lingo when it comes to an object’s color. Remember these
terms when you make like Picasso with your shapes, text boxes, graphics,
and clip-art images:

DrlshapeFile * Shape fill colors: The color that fills in an object is called the shape fill.
You can apply shape fills to shapes, text boxes, and WordArt images,
but not clip art or graphics. Besides colors, you can fill a shape with a
picture, a gradient, or a texture. (See the next topic in this chapter,
“Filling an object with a color, picture, or texture.”)

o shape outine -~ ¢ Shape outline colors: The line that goes around the perimeter of the
object is called the shape outline. You can choose a color, style, and line
width for outlines. (See “Putting the outline around an object,” later in
this chapter.)

WBER The easiest way to decorate a shape, text box, or WordArt image is to visit
the Format tab and make a selection in the Shape Styles gallery. These
ready-made gallery selections can spare you the work of dealing with fill
colors, outlines, and shape effects. Just remember not to mix and match dif-
ferent Shape Style options; use them with consistency.

Filling an object with a color, picture, or texture

Shapes, text boxes, and WordArt images are empty when you first create
them, but you can fill them with a color, picture, gradient, or texture by fol-
lowing these basic steps:
1. Select the object that needs a facelift.
S shiape Fill - 2. On the Format tab, click the Shape Fill button.
3. On the drop-down list, choose a fill color, picture, gradient, or texture.
Choose No Fill to remove the fill color, picture, gradient, or texture from

an object.

Figure 8-17 shows the same object filled with a color, picture, gradient, and
texture. Which do you prefer? Your choices are as follows:

4+ Color: Applies a single color to the object.



